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Chapter 1

Using the Application

1.1 What is Battery Monitor?

More and more computers are mobile devices nowadays. The most important prerequisite
for a portable computer is a chargeable battery which keeps the device powered. Batter-
ies are not really cheap replacement parts and they are subject to wear and tear. Their
lifetimes should be optimized, handling them with the necessary care. Battery Monitor is
a small auxiliary application useful in this regard. It offers the following features:

• DISPLAY OF THE CHARGE STATE IN THE DOCK. This is useful if you cannot or do not
like to use the display in the menubar of macOS, e.g. when you have a screen which
is not very wide.

• DISPLAY OF INTERNAL BATTERY INFORMATION. In addition to the charge state,
many other technical specifications, e.g. temperature, discharge current, number
of charge cycles, or capacity can be retrieved. The states of each of the battery cells
can also be determined.

• CAPTURING CHARGE AND DISCHARGE CURVES. The history of the readings mea-
sured by the battery unit can be displayed graphically. This way you can plot the
charge and discharge curves, for example, one of the most important characteristics
for the health of a battery. You can also review the graphical profile of the amperage
drawn by the computer, helping to find “power guzzling applications”.

• BOOKKEEPING OF THE AGING PROCESS OF THE BATTERY. Battery Monitor automat-
ically keeps a log about the charge capacity of the battery which will decrease as the
battery ages. This helps you to exactly monitor how the behavior of the battery is
changing over time. You can assess if your battery is working normally or if it might
be defective. You can also estimate more exactly when the right time has come
to purchase a new battery. For computers with replaceable battery units, Battery
Monitor can of course monitor multiple battery packs at the same time.

• NOTIFICATIONS DURING CHARGE OR DISCHARGE. In addition to the display of the
charge state in the Dock, Battery Monitor can optionally inform you about the

1



2 CHAPTER 1. USING THE APPLICATION

progress of the charge or discharge process by other means. Unobtrusive notifi-
cations using speech or the macOS notification center can be set up.

• ADDITIONALOVERVIEWOFCONNECTEDBLUETOOTHBATTERIES. If supported Blue-
tooth devices powered by batteries are connected to your Mac, display of their bat-
tery levels can be integrated into Battery Monitor as well.

1.2 System Requirements

To use Battery Monitor, you will need the following components:

• A computer containing a battery or battery slot compliant with the Smart Battery
standard (section A.4 on page 49). All portable Apple computers with Intel or ARM
(Apple Silicon) processors fulfill this requirement.

• The operating system macOS 13 Ventura or a later version. Apple may additionally
offer older versions of Battery Monitor in the App Store for use with operating sys-
tems down to Mac OS X 10.6.6 Snow Leopard.

Note: Battery Monitor does not support batteries of Uninterruptible Power Supplies
(UPS). Such devices do not adhere to the Smart Battery Specification. In fact, the
communication of UPS units does not follow any common industry standard, because
such a standard unfortunately has not been defined yet.

1.3 Displaying Battery Information

After launching the application, the Overview Window of Battery Monitor will appear. It
shows all important operational data of your battery and information about your com-
puter. If you have closed the window, you can reopen it again by selecting the menu item
Window > Overview or by pressing the key combination ⌘ + 1 .

The window contains the following items:

1.3.1 Battery Information

• Battery Controller: The name of the battery unit, or more specifically, its controller
hardware. This name is defined by the vendor of the battery. In most cases, it is
a part number specifying the micro-controller chip that monitors the unit. In this
manual, we use the term battery processor for this chip.

• Serial number: The serial number of the battery. Each battery can be uniquely iden-
tified by model name and serial number, e.g. when you have multiple battery packs
in use, or after a defective battery has been replaced. If two numbers are displayed
here, the actual serial number is the number in parentheses, while the first number
specifies the serial or revision number of the controller firmware.
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Figure 1.1: Battery Monitor Main Window



4 CHAPTER 1. USING THE APPLICATION

• Pack/PCB Lot Codes: The lot codes of the battery pack and its printed circuit board.

• FW/HW/Cell Versions: The version codes of the firmware, the hardware, and the
battery cells.

Modern battery units from Apple typically use the Impedance Track™ Battery Gas
Gauge Chipset from Texas Instruments as battery processors. These controllers iden-
tify with a chip code beginning with “bq20z…”.

1.3.2 Computer Information

• Computer model: The name of the computer model on which the application is
currently running. The model type is additionally symbolized by a little icon. This
feature is only available on computers made by Apple. If the model specification is
very long, it might be clipped at the window border. In this case, hold the mouse
cursor over the line. The complete model name will be shown as help tag after one
second.

• Serial number: The serial number of this computer.

• Manufacturer: The manufacturer of the computer, as specified during production.

• Manufacturing date: The week in which this computer has been assembled.

For Apple devices manufactured after August 2021, Apple may no longer permit that
the actual manufacturing date can be determined. In this case, Battery Monitor will
indicate this with a respective message.

1.3.3 Battery Status

• Voltage: The voltage currently supplied by the battery, or being used to charge it,
respectively.

• Current (Amperage): The current supplied by the battery at the moment, or be-
ing used to charge it. Some batteries represent discharging currents by a negative,
charging currents by a positive number. You can influence this by a preference set-
ting.

• Power: The power currently being delivered by the battery, or the power it is charged
with, respectively.

• Temperature: The temperature currently being measured by the battery within the
battery unit. The temperature unit can be controlled by a preference setting.

• Current charge: The remaining capacity estimated by the monitoring processor of
the battery, describing its current charge state in milliampere-hours.
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• Percentage value: The current charge is also shown as percentage value and as a
colored bar. The value can either be set to reflect the true charge level as reported
by the battery unit, or to show a value which is designed for presentation to the
user. Typical batteries have a specific charge level where they are “almost” full and
continued charging to the “really full” level becomes significantly slower. When
connecting an AC adapter to an almost full battery, the Mac may decide not to con-
tinue charging in order to optimize battery lifetime. To reflect this typical behavior
to the user, many applications consider the “almost full” charge level as “100%” al-
ready, although it is actually below the true 100% capacity value. You can switch
between the two display modes in the settings panel. A note below the charge level
bar will inform you if the “true” display mode is selected. For more information,
please also see section “Settings” later in this chapter.

If you are using a recent version of macOS with a recent Mac, Battery Monitor will
display a help button with a question mark next to the battery status bar. If you click this
help button, you can display a graphical overview that further clarifies the differences
between the percentage given by macOS and the actual charge level of the battery cells.

Figure 1.2: On selected Macs, Battery Monitor can visualize the strategy used by macOS
when charging and indicating percentage values.

Battery reserve shows the value at which macOS puts the computer into hibernation
as a precaution to avoid deep discharge of the battery. In reality, the cells still have enough
energy at this point to keep the computer in standby mode for a longer period of time,
as well as to operate the screen, showing the “Battery empty” graphic. If you are using
an up-to-date version of macOS and you have enabled the item Battery > Battery Health
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> (i) > Optimized battery charging in the System Settings application, the specific value
at which macOS stops charging under certain conditions to save the battery is shown at
Possible charging end point. You can also see the differences between an “almost full”
and an “actually full” battery.

• Estimated remaining time: The remaining run time in hours and minutes for the
current charge, estimated based on the current power consumption of the com-
puter. Immediately after power-on, on startup, or wake-up, no estimated value will
be available yet, or the value can be very inaccurate. This will change after a few
minutes, however, when more measured data becomes available, so the estimate
can be determined more precisely. The run time is computed by the battery proces-
sor and macOS, not by Battery Monitor. When the computer is connected to an AC
adapter, the display automatically changes to Estimated time until full. When full,
the line will disappear.

• Battery defects: If the system detects one or more technical faults within the battery
unit, the number of problems will be reported here. In that case, you can press the
button More info next to this line to see the reported failures in detail. Additional
notes on this feature are given in the next section.

• Charger connected: This status display allows you to see if the AC adapter of the
computer is currently connected. If the computer receives external power, the dis-
play will light in green. In this case you can also press the button More info in the
same line to display technical details about the AC adapter. The amount of data
available can vary greatly depending on adapter. This can only be guaranteed to
work correctly for original Apple-branded adapter units. An example is shown be-
low. If using a power supply with USB-C technology, the amperage value (which
controls the power provided and is directly responsible for the charging speed) will
be negotiated between power supply, a controller built into the USB-C charger ca-
ble, and the computer. In this case, the report window will indicate the current
mode of operation.

• Charging: This status display will light if the battery is being charged by an attached
power supply.

• On reserve power: The status light indicates that the computer is running on reserve
power. For most versions of macOS, this will mean that you can continue your
work at the current power consumption level for approximately 10 minutes until
the battery will be dead. This is an estimate of the battery processor and macOS.

1.3.4 Battery Defects

The battery controller keeps an internal error log that stores abnormal operation events
recorded in the past. Such event entries are called “permanent battery failures”. Battery
Monitor and macOS can decode 14 different types of failures stored in the battery unit.
They constitute the defect list shown when you press the More Info button at Battery
defects.
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Figure 1.3: Example report for an Apple AC adapter. For power supplies with USB-C tech-
nology, the report also indicates the current charging mode as negotiated by the devices.
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Each recorded failure type appears as a line in the battery defect table. Because the
battery unit does not contain its own clock, the records have no associated time infor-
mation and their order may not reflect the actual sequence in which the events occurred.
The different types of defect descriptions should be self-explanatory.

Figure 1.4: Example report for a battery that has registered abnormal events in the past

Note that an entry recorded in this list does not necessarily mean that the battery is
still defective at the moment. It just indicates that a failure situation has occurred during
the lifetime of the unit in the past. Usually, only the vendor of the battery unit can reset
the battery’s failure log, using special software which is not available to the public. If a
battery unit has been repaired or refurbished, connecting new battery cells with a used
battery controller, but the service technician has forgotten to clear the permanent failure
memory, the defect list could be outdated and therefore be incorrect.

1.3.5 Battery Health

• Charge cycles: The number of complete charge and discharge operations that have
been performed during the lifetime of this battery. The monitoring processor in the
battery unit determines what is considered to be a complete cycle. The number of
charge cycles is one of the main factors influencing wear and tear of the battery.

• Expected cycles left: This value represents the number of remaining complete charge
cycles after which Apple recommends to replace the battery unit by a new one. The
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percent value additionally represents how much of the expected lifetime has been
consumed already.

This value only represents the official replacement policy of Apple and is only valid
for original Apple parts, not for battery units of other vendors. It does not take into
account the actual health of the battery.

• Maximum capacity: The capacity the battery can hold in its current state when
it is fully charged. This reading decreases with advancing age. It is an estimate
computed by the processor within the battery unit. By calibrating (section A.3 on
page 48) the battery, the estimate will become more accurate. The expected error
of the estimate is also shown between parentheses if such information is provided
by the battery processor.

• Original capacity: This is the maximum capacity this battery has been designed for.
The battery had this capacity when it came straight from the factory. The relation
between maximum and original capacity is additionally shown as percentage and as
colored bar. For brand-new batteries, this value can temporarily grow above 100%.
In this case, the battery can store more energy as it has to, according to specifica-
tions.

For specific Macintosh models and operating system versions, System Settings
(System Preferences in old versions of macOS) also shows a value for the current
maximum capacity of the battery. In certain cases, this value can deviate from the
value displayed by Battery Monitor. Battery Monitor always shows the up-to-date
value, which was determined by the battery monitoring processor based on the ob-
servation of the last charge cycle. Apple’s value, on the other hand, is calculated as a
nominal long-term capacity, which includes extended observations of the battery be-
havior and additional correction factors, such as the operating temperature. Macs
with Apple chips are particularly affected by this, as they no longer use the classic
battery monitoring of macOS, but a control system taken over from the iPhone.

Battery Monitor can detect if you are using a Mac that may be operating under two
different definitions of “maximum capacity”. In this case, a help button with a question
mark icon is displayed next to the bar graph. If you click this button, the two capacities
will be compared.

• Assessment: The overall assessment of battery health, as defined by macOS. Under
normal circumstances it will beGood. In case the battery is deteriorating, additional
notes why the battery is no longer considered healthy, may be shown below this line.

• Cell voltages: The battery is in fact made up of multiple battery cells, which can be
arranged in parallel or serially. These actual batteries and the monitoring processor
form the battery unit. Depending on design, each unit can contain between 1 and 4
individual cells. The voltage of each cell is shown numerically and by a colored bar.
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Figure 1.5: There can be two different definitions of maximum capacity in certain cases.

Current computers use battery cells based on lithium ion technology. Under load,
the voltage of a cell will be between 3.3 and 3.8 volts, depending on cell type. The
maximum charge voltage of a fully charged cell is approximately 4.2V. Under optimal
circumstances, the behavior of all cells of a battery (including their voltages) should
be equal, because they have been constructed identically. A worn-out or defective
battery can often be detected by a voltage of one cell differing significantly from
the voltages of the other cells, because this cell is no longer capable of performing
according to its specifications.

The number of battery cells reflected to the outside may not always match the
true physical number of cells. For example, a long-life unit with 6 cells might pretend
it is actually composed of 3 cells only. For technical reasons, Apple battery units can
only report a number between 1 and 4 available cells to the outside.

1.3.6 Long-Term Data

Newer Macintosh models contain battery controllers that also record long-term data
about the battery cells, storing the information permanently, completely independent
of the computer. The internal flash memory of the controller is used for this. If Bat-
tery Monitor detects such a feature in your Mac, the data can be retrieved via the button
Long-term data that appears at the bottom of the box Battery Health.
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The amount of accessible data can differ significantly depending on the Mac model.
You may only get the full dataset with MacBooks using Apple Silicon.

Figure 1.6: Some Macs permit to retrieve long-term battery data.

If available, you can read the extreme values   for voltage, current and operating tem-
perature recorded during the lifetime of the battery. The discharge current is tradition-
ally given as a negative value. Under Battery disconnected you will find an indication of
whether the battery unit has been cut off from the associated Mac one or more times in
the past. The Memory write operations value indicates how often long-term data was
written to the flash memory of the battery. The various capacity values   form a part of the
dataset on which macOS bases its own battery health percentage (see above). The hour
meter of the battery can also be read out, as well as the information when the last charge
cycle from “completely empty to completely full” occurred.

1.4 Overview of Batteries in Connected Bluetooth Devices

As an additional feature, Battery Monitor can also give you an overview of batteries that
have been detected in Bluetooth devices currently connected to your Mac. Such devices,
for example wireless trackpads or keyboards, are powered by internal batteries. To see
the list, select the menu item Window > Bluetooth Battery Overview or press the key
combination ⌘ + 0 .

Next to the name and serial number of each device, you’ll see the current battery
capacity, both as a bar indicator and numerical percentage value. An additional color
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Figure 1.7: Overview of batteries in selected Bluetooth devices

marker indicates whether the battery state is considered normal (green) or in a warning
situation (red), running on reserve. If the marker is missing, the respective device does
not support a continuous battery alert status. Battery Monitor tries to detect as many
batteries in classic Bluetooth or Bluetooth Low Energy devices as possible, but we cannot
guarantee that all connected devices are listed here. Some vendors use encryption to
intentionally protect their battery data against access by third-party software.

A Bluetooth device must be connected to your Mac to appear in the overview window.
You cannot monitor devices which are just in the neighborhood.

For technical reasons, Battery Monitor cannot detect whether a Bluetooth device is
powered by a rechargeable battery or a single-use battery (primary cell). The external
device alone is responsible for monitoring and taking care of the battery, so it usually
doesn’t provide any additional details of its power unit the Mac should “know” about. So
the overview can just serve as additional convenience. Bluetooth batteries won’t become
part of the history data or any notifications managed by Battery Monitor.

For input devices by Apple, like keyboards and mice, Battery Monitor may provide
the additional feature to still track the device even when it is disconnected from
Bluetooth, but charged via USB on the same computer. The indicator (via USB) will
then be shown behind the device name.

Note that such Apple devices may sometimes show their Bluetooth addresses in-
stead of their actual serial numbers which is based on a known technical limitation of
macOS. Battery Monitor will automatically try to learn which serial number belongs
to which address to avoid this issue.
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1.5 Display in the Dock

While Battery Monitor is running, the current charge state of the battery can also be seen
within the Dock tile of the application. The state is represented by a combination of level
indicator in a battery symbol, an arrow, color and icons. The display is similar to the
menu-bar icon for the battery state shown by macOS and should be self-explanatory. An
additional numerical percentage value can be added if desired.

As mentioned before, the shown status can either reflect the true physical or the fake
user-oriented charge percentage, depending on what display option you have chosen.

In addition to the graphical display, you can open the context menu of the Dock tile to
see the charge level and the estimated remaining time as numerical values. Just right-click
the icon of Battery Monitor in the Dock.

1.6 Settings

Several aspects of the application can be customized to your personal needs. The settings
can be reviewed after selecting the menu item BatteryMonitor> Settings… or by pressing
the key combination ⌘ + , :

Preference settings are divided into three categories. You can use the tabs General,
Menu Bar and Notifications to switch between them.

1.6.1 General Settings

• Temperature unit: Choose if the temperature should be shown using degrees Cel-
sius, degrees Fahrenheit, or Kelvin.

• Charge level: As already mentioned earlier in this chapter, the percentage value to
indicate battery charge status can either be set to reflect the true charge level as
reported by the battery unit, or to show a value which is designed for presentation
to the user. Select either Show user-oriented charge level (as in menu bar) or Show
true charge level (as in System Information). Your choice for the display of charge
level percentage does not only control the related field in the main window, but
also has influence on all other parts of Battery Monitor. The battery icon in the
Dock and the notifications that can be sent at specific percentage levels will also
use the preferred output mode you have chosen. Please also see the note at the end
of this section.

• Dock display: The pop-up menu allows you to choose whether an additional value
should be shown in the lower right corner of the Dock tile. You can add either the
percentage value for the charge level, or the remaining time. If the time is shown
as a positive value, this will be the estimated remaining runtime of the computer
until the battery needs to be recharged. A negative value indicates the estimated
time until the battery will be fully charged. Note that the additional text display can
slightly increase power consumption of the App. If such readings are shown in the
Dock tile, you can enable the option Large value display to magnify the data. The
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Figure 1.8: Battery Monitor Settings
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large display uses approximately twice the normal height and can be helpful if you
have many objects in the Dock.

• Amperage display: If you are using a battery unit which differentiates between
charge and discharge states by changing the sign of the amperage value, you will
be able to control this by the item Allow negative currents to indicate discharge
status. After switching this off, Battery Monitor will use positive current readings
only.

• Overview window: When the checkmark is set for the item Open automatically
when switching to application, the main window of the application will be shown
upon each start. This is also the case if you close the window, work with another
program, and then return to Battery Monitor, or click the applications’s icon in the
Dock. You might like to disable this feature if you mainly use the status display in
the Dock and need the window on demand only.

• History Windows: Synchronize time axes for all windows: The history windows
for capacity, current, and voltage contain pop-up buttons to determine the time in-
tervals you like to see in the graphs. If this option is enabled, you will only have to
set the time interval for one history window. All other windows will then automat-
ically switch to the same time frame. With this feature switched off, you can select
a different monitoring time for each of the windows.

• History Windows: Use standard windows: By default, Battery Monitor uses so-
called head-up display windows with a black, transparent background to show his-
tory data. If you like to use conventional windows instead, check this item.

• History Windows: Show capacity history as percentage: Capacity is measured in
milliampere-hours and absolute readings with this unit are shown in the corre-
sponding history graph. If you prefer the display of relative values however, namely
as percentage of the current total capacity of your battery, you can enable this al-
ternative view here.

Most applications at the user level, for example Apple’s battery icon in the menu
bar, prefer the percentage value for user presentation to indicate the charge level.
Because different applications access the battery at different points in time and also
use different rounding policies, there can sometimes be a difference of ±1 percentage
point. The indicator in the MagSafe connectors of older Apple AC adapters also use
the user-oriented “100%” level to switch from orange to green if used with up-to-date
Macs and macOS versions. Most applications at the technical level, e.g. the macOS
command-line tools for power management or the System Information application
reflect the true percentage value, however.

If you are operating the App without a Dock icon (section 1.9 on page 19), macOS
will remove all typical user interface elements usually available to re-activate the
App after you have worked with a different program. To switch to Battery Monitor,
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you will then use the menu items at its icon on the right hand side of the menu-
bar instead. The setting Overview window: Open automatically when switching to
application will also take effect in this case.

1.6.2 Settings for the Menu Bar

Older versions of OS X and macOS supported a feature to show the estimated remaining
runtime of the battery directly in the menu, accessible via the battery icon in the menu
bar. Apple removed this feature from this location with macOS 10.12.2 and later versions
of the operating system. If you are using one of the affected OS versions, Battery Monitor
can be used as a replacement to restore this lost function. This is explained in a separate
chapter (section 1.9 on page 19).

1.6.3 Settings for Notifications

• Calibration: A warning can be shown when the battery unit detects that the esti-
mated error of the maximum capacity value becomes too large. Battery capacity
cannot be measured directly, it can only be estimated by observing the behavior
of the battery during a full discharge/charge cycle. The estimate becomes too in-
accurate when a full cycle could not be observed for some time. In this case, the
recorded data is outdated and may no longer reflect the true state of battery health.
The readings for capacity and remaining run time become less and less accurate.
Battery Monitor can warn you when the estimated error exceeds a certain thresh-
old. To do this, set a check mark at Warn when estimated error becomes too large.
If you receive such a warning, you should re-calibrate (section A.3 on page 48) the
battery at your earliest convenience.

• Send capacity notifications: If required, Battery Monitor can send you a notification
after certain charge or discharge conditions have been reached. This notification is
unobtrusive and won’t disturb you during work. You can let the application inform
you about the following events:

– when the battery has been discharged so far that it is running on reserve.

– when the battery has been charged to full capacity and the system has actually
finished the charging procedure.

– when the battery has been charged to the “almost full” level, presented as 100%
by user applications.

– when discharging, after every 10 percent of capacity have been reached, i.e.
90%, 80%, etc.

– when charging, after every 10 percent of capacity have been reached, i.e. 10%,
20%, etc.
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macOS will already give you an automatic warning when the battery is running on
reserve power. So the option When running on reserve of Battery Monitor should
only be activated if you have suppressed the original warning of macOS for some
reason.

Independent of the single “reserve” warning, you can also activate more nagging, re-
peating warnings, if the charge levels drops below a certain level. The level can be ad-
justed between 5% and 20%. The reminder message please connect the AC adapter will be
repeated every 5 minutes. To use this feature set a check mark for the option As nagging
reminders when below and set the threshold value with the slider below it.

The maximum limit for this feature is usually 20% which can mean 4 remaining hours
of operation for an up-to-date Mac with healthy battery. For old Macs with a defective
battery, you may like to set an even higher limit, however. Hold down the option key
⌥ and click on the numeric value next to the slider to unlock a wider range of possible

settings. When you do this, you can set the warning threshold up to 66%.

Figure 1.9: Battery Monitor: Notification Settings

Battery Monitor can deliver the aforementioned kinds of notifications either via Notifi-
cation Center or acoustically by voice (or both). You can control this by the check marks at
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Notification Center and Speech. Note that no notifications will occur if you disable both
options. The types of notifications will be explained in more detail in the next section.

Immediately after your computer has woken up from sleep mode, Battery Monitor
won’t send notifications for some seconds. Operating system and monitor hardware
need a certain time to recover from sleep mode which can temporarily result in wrong
status information. Battery Monitor waits until the system has stabilized.

1.7 Notifications via Notification Center

You can setup the details as desired by using the pane Notifications in the application
System Settings of macOS (System Preferences in old versions). After Battery Monitor
has sent at least one notification message, macOS will offer you the detail settings for the
application.

Battery Monitor automatically removes outdated notifications, so you won’t be flooded
by charge records from the past which no longer make sense. The Notification Center au-
tomatically suppresses notifications while you are working with Battery Monitor in the
foreground.

1.8 Notifications via Speech

Battery Monitor can also deliver notifications by spoken language. You can control the
type of voice and the speed as follows:

1. Open the application SystemSettings (SystemPreferences in old versions of macOS).

2. Navigate to the preference pane Accessibility.

3. Select the item Spoken Content (Speech in old versions of macOS) in the overview
of accessibility functions.

4. Choose your preferred voice with the pop-up button at System Voice and the speed
with the slider Speaking Rate. The button Play Sample can be used to test your
current settings.

It is recommended to use the menu item Customize… of the System Voice pop-up
button to select one of the voices for your primary language and to activate high-
quality speech mode. High-quality output requires an additional download which is
available for free from Apple. Battery Monitor automatically tries to find the “best”
voice from your list of available voices which matches the language in which the
application is currently running.
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1.9 Using the Menu-Bar Display

1.9.1 Enabling the menu-bar display

By setting a check mark at the option Show battery status in menu bar on the tab item
Menu Bar of the Settings window, you can add an optional battery display to the right
side of the menu bar of macOS. This status item of Battery Monitor can be used as an
alternative to the original battery icon of macOS. It provides a slightly different set of
features and brings back the possibility to indicate the estimated remaining runtime in
the menu.

If you like to show the percentage value for charge level next to the battery icon, also
set a check mark at Show percentage. If you like to hide the battery icon in the menu bar
in this case, which will allow you to combine Apple’s battery icon with the percentage
value of Battery Monitor, additional check the item Show percentage only, suppressing
battery icon.

Figure 1.10: Settings for the Menu Bar

Although the basic battery icon used by Battery Monitor looks very similar to the orig-
inal version used by macOS, the detail behavior of icon and menu will differ. Battery
Monitor does not try to copy Apple’s functions:
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• Different wordings are used in the menu items.

• Battery Monitor must not indicate the application which is currently consuming the
most energy. Observing technical details of other programs is prohibited for Apps
from the Mac App Store.

• The icon of Battery Monitor continuously visualizes the current charge level, even
while the battery is charging or the system is powered by AC adapter after the battery
is fully charged.

When the battery is running on reserve power, the icon will switch to a red bar indi-
cator. Battery Monitor needs to be running to show its icon in the menu bar.

The charge level indicated in the menu bar also respects your current preference
(section 1.3 on page 2) to either indicate the true physical level or the user-oriented
fake value.

1.9.2 Choosing a position for the menu-bar display

You can set a preferred position for the battery icon in the menu bar. This position will
automatically be remembered the next time you are launching Battery Monitor. You can
set any position at the right side of the menu bar between the menu of the current front
application and the icon of Notification Center. To set a new position,

1. hold down ⌘ ,

2. drag the battery icon to the desired location in the menu bar, and

3. release the ⌘ key.

1.9.3 Removing the menu-bar icon

You can remove the optional battery icon from the menu bar by modifying your settings:

1. Select the menu item Battery Monitor > Settings … or press the key combination
⌘ + , .

2. Switch to the tab item Menu Bar.

3. Remove the check mark at Show battery status in the menu bar.

You can also remove the icon by dragging it out of the bar:

1. Hold down ⌘ .

2. Drag the battery icon from the menu bar some distance away until a close marker
appears.
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3. Release the ⌘ key.

The original battery icon of macOS can be removed the same way.

1.9.4 Using the menu of the battery icon

By clicking the battery icon, you can open its attached menu. It provides several additional
status indicators and can be used to select several functions quickly.

Figure 1.11: Several features are available in the menu

• The first line gives a short summary on battery health (section 1.3 on page 2).

• The second line indicates the estimated remaining time until the battery is either
empty or full. This value is computed by macOS.

• The third item indicates the current power source.
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• If battery-powered Bluetooth devices are listed in the Bluetooth overview window
(section 1.3 on page 2), a short summary of the respective charge states will be
inserted as an additional section here. There will be one menu item for each of the
devices.

• The item Show Overview Window can be used to quickly bring Battery Monitor to
the front, opening its main display window.

• The item ShowPercentage can be used as switch to enable or disable the percentage
reading in the menu bar.

• The item Suppress Battery Icon allows you to show the percentage only.

• The last menu item navigates to the respective pane for energy control.

1.9.5 Remove the Dock icon to control the App from the menu bar only

After you have enabled the menu-bar display of Battery Monitor, it will be technically
possible to control the App from the menu bar only. You can additionally remove the
Dock icon, forcing macOS to handle Battery Monitor as a menu-bar tool. In this special
mode of operation, macOS will remove the main menu of the App as well. Battery Monitor
automatically compensates for that by adding the most important items of the standard
menu to the menu of the menu-bar display.

To remove the Dock icon, perform the following steps:

1. Select the menu item Battery Monitor > Settings … or press the key combination
⌘ + , .

2. Switch to the tab item Menu Bar.

3. Set a check mark at Remove Dock icon.

The main menu will now appear embedded within the menu of the menu-bar icon,
replacing the previous ShowOverviewWindow item. The original order of the main menu
from left to right will be kept in the simplified menu, grouping the different submenus
into separate sections top down.

If you operate Battery Monitor without Dock support, the policy for automatic
restoration of windows and their placement on screen will be slightly different. This
complies with Apple’s rules for tools that run in the menu bar only.

Battery Monitor will automatically switch to standard mode again if you either disable
the menu-bar icon or the Dock icon removal option:

1. Click on the icon of Battery Monitor in the menu bar.

2. Select the menu item Settings… in the section Battery Monitor.

3. In the settings window, switch to the tab item Menu Bar.
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4. Remove the check mark at Remove Dock icon.

If you the switch the Dock icon on or off, all open windows of the App will temporarily
disappear for one second. This is normal.

1.10 Monitoring Charge and Discharge Behavior

When Battery Monitor is running, all operational data about the battery will be contin-
uously recorded each minute. This makes it possible to monitor behavior of the battery
over a longer time interval using curves in a diagram. The following graphical evaluations
are available:

1.10.1 History “Capacity”

In this diagram, the current capacity (the charge state), maximum capacity and original
capacity (see battery health (section 1.3 on page 2)) can be compared to each other. The
charge and discharge curves of the battery can be monitored precisely. To open this dia-
gram, select the menu item Window>History “Capacity” or press ⌘ + 3 . By changing
a preference setting (section 1.3 on page 2), you can select either mAh or % as unit for the
curves.

Figure 1.12: Battery Monitor Charge Curve
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1.10.2 History “Current”

This diagram shows the history of the current flowed over time. You can use the curve to
monitor how much power your computer has been drawing from the battery. This can
help to identify “power guzzling” applications or devices (screen backlight, WLAN trans-
mitter, external hard drives, etc.), controlling better how the electrical energy is being
used during the day. The display can be opened by Window > History “Current” or by
pressing ⌘ + 4 .

1.10.3 History “Power”

The curve named “Power” visualizes the power the battery has delivered over the mon-
itored time interval, or the power it has been charged with, respectively. Similar to the
history “Current”, this display can also help to identify the electricity consumers in your
computer. The power values basically summarize the voltage and amperage histories.
The graphic is displayed after selecting the menu item Window > History “Power” or by
pressing ⌘ + 5 .

1.10.4 History “Voltage”

In this panel you’ll find the total voltage measured at the battery unit, either with the
AC adapter connected or not. The diagram will be shown after selecting the menu item
Window > History “Voltage” or by using the key combination ⌘ + 6 . When using a
virtual key in the Touch Bar to open the window, it will be identified as Vt for “voltage,
total”.

1.10.5 History “Voltages (Cells)”

This graph shows the individual voltages of each of the cells in the battery unit. In many
cases, this diagram can be used to assess if one of the cells is possibly defective, because
such a cell usually behaves differently over time compared to the other cells. The diagram
will be shown after selecting the menu item Window > History “Voltages (Cells)” or by
using the key combination ⌘ + 7 . When using a virtual key in the Touch Bar to open
the window, it will be identified as Vc for “voltage, cells”.

1.10.6 History “Temperature”

The temperature readings from the battery, as measured by the main sensor of the battery
controller. To open the history graph, select the menu item Window > History “Temper-
ature” or press the key combination ⌘ + 8 . The window automatically uses your
preferred temperature unit.
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1.10.7 Aligning History Windows

If several history windows are on screen at the same time, it can be useful to put them
either on top of each other or to align them vertically, making it easier to inspect matching
points on the curves. Select the menu item Window> Superimpose History Windows to
let the graphs display “front to back”, utilizing the transparency of the windows. Select
the menu item Window > Stack History Windows, or press ⇧ + ⌘ + T to collect the
windows top-down aligned on the right half of the screen. Sizes and positions will be set
automatically. The App tries to keep your previously chosen top-down order when doing
so.

When using automatic alignment, it is helpful to also enable the feature History win-
dows: Synchronize time axes for all windows in the settings (section 1.3 on page 2).

1.10.8 Opening or Closing all History Windows Simultaneously

If your monitor screen is large enough to work with all history windows at the same time,
you may like to open and close them all together. For opening them, select the menu item
Window > Show All History Windows or press ⇧ + ⌘ + H . For closing them, select
the menu item Window > Close All History Windows or press ⇧ + ⌥ + W .

1.10.9 Matching Selected Time Events

To exactly match a specific point in time between the different history windows, synchro-
nization markers can be shown in the graphs. This is particularly useful when you have
set different time intervals for the windows.

Click on any point in the graph area. Little circular markers will appear on all curves in
all history windows that specify the selected point in time. In addition, the actual readings
at that point in time will be shown. To remove the markers and the detail values, click
into an area of any of the history windows outside the 4x4 box.

Hint: You can also drag the marker along the curve. It is recommended to switch
the history windows to conventional style in this case, using Settings > General >
History windows: Use standard windows, in order to avoid that the window moves
while you drag.

1.11 Additional Notes

As mentioned already, the readings can only be captured and recorded while the appli-
cation Battery Monitor is running. If the windows of the application are visible or not,
won’t play any role. If your computer is switched off or is in sleep mode, no values can
be stored. This will become apparent as gaps in the curves. If you like to monitor the
behavior of the battery as continuously as possible, it will be recommended to let the
application launch automatically (section A.1 on page 47) and not to quit it.
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The scale of each diagram will be determined automatically in horizontal and vertical
direction, zooming into the curves to reach a presentation as clear as possible. You can
review up to 12 hours into the past, while time is advancing from the left to the right
in the diagram. This means present time is shown at the right border, while the past is
visible to the left. The time interval to be shown can be controlled by the pop-up menu
in the lower left corner of the window. You can choose between 1, 2, 4, 6, 12, 24, and 48
hours.

When launching the application for the first time, the graphs will be empty because
no readings have been recorded yet. After approximately 2 minutes, the first curves will
appear in the history panels. When you quit the application, readings already recorded
will be kept. After you have relaunched the program, data which has been recorded within
the previous 48 hours can still be monitored.

If needed, you can transfer the recorded values to other applications (section 1.13 on
page 31).

1.12 Logging the Aging of the Battery

With increasing age of the battery, its performance will degrade. The value for maximum
capacity (section 1.3 on page 2), corresponding with the amount of energy the battery can
hold, will decrease, deviating more and more from the original capacity of a brand-new
battery. Because the amount of stored energy is getting smaller, you won’t be able to
operate your mobile computer disconnected from mains as long as before.

Aging of the battery depends on chemical and physical processes within the battery
cells. It can accelerate by false treatment, e.g. temperatures too high or too low. Aging
processes are usually gradual and can only be detected by monitoring over several months.

Battery Monitor can help you to review the capacity of a battery unit over long time in-
tervals. For this purpose, no action is required of you. You only need to take care that Battery
Monitor is running as often and as long as possible. For this reason, it is recommended
to let the program start automatically (section A.1 on page 47).

1.12.1 Displaying the Log

When Battery Monitor is running, the program will record the present value for maximum
capacity once a day in a log. You can review the log using the menu item Window >

Capacity Log, or by pressing ⌘ + 2 , respectively. The log is shown in form of a table.
The left column shows model name and serial number of the battery used, the center
column the respective date, and the right column the capacity of the battery at that time.
The table is automatically sorted by battery and date. Values for a specific battery can be
hidden or shown using a disclosure triangle.

Battery Monitor is recording values for any number of battery units. This is important if
you have a computer with replaceable batteries and you are using multiple battery packs,
or if a built-in battery had to be swapped, or if you are using multiple mobile computers
in a network with a centrally stored home folder.

Note that the monitoring processor in the battery unit is regularly calibrating (section
A.3 on page 48) itself to enhance accuracy of its readings. This can lead to capacity readings



1.12. LOGGING THE AGING OF THE BATTERY 27

Figure 1.13: Battery Monitor Capacity Log

sometimes increasing, although the usual wear and tear will normally result in decreasing
values.

The readings can be transferred to other applications (section 1.13 on page 31) if needed.

1.12.2 Presenting the Log Graphically

The log of capacity values can also be shown in a graphic representation. By pressing the
button View as graph at the top border of the capacity window, you can toggle between
the textual and graphical view. It also possible to open the capacity log directly in graph
mode by selecting the menu item Window > Capacity Graph, or by pressing ⌘ + ⇧ +

2 , respectively. The history of each battery is presented in a different color. An addi-
tional dotted line shows the general downhill trend noted usually for batteries. “Today’s”
capacity is shown at the right hand side of the window, the oldest recorded state can been
seen on the left.

1.12.3 Choosing a Better Name for a Capacity Log

Battery Monitor uses the internal device names and serial numbers of batteries to refer
to the different modules you have used in the past. Depending on manufacturer, these
names may not always be readable well. You can specify a customized name for the log
entries of a battery if you like. For example, you could decide to give the battery you have
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Figure 1.14: Battery Monitor Capacity History

purchased in August 2016 the name Batt 08/2016. Perform the following steps to rename
a battery in the capacity log:

1. Make sure the window Capacity Log is open and is showing readings, not the graphs.

2. In the column Battery, click onto the line with the battery you like to rename.

3. Right-click the entry and select the item Rename Battery… in the context menu.

4. Enter the new name for the battery and press the OK button.

1.12.4 Deleting the Log of an Old Battery

When you had to replace a battery unit by a new one, because the old one reached the
end of its life, you might decide to no longer keep the log of the replaced battery. You can
delete all log entries of a specific battery unit as follows:

1. Make sure the window Capacity Log is open and is showing readings, not the graphs.

2. In the column Battery, click onto the line with the battery you like to remove.

3. Right-click the entry and select the item Delete Battery… in the context menu.

4. Confirm that you actually want to delete all log entries that have been recorded for
this battery unit.
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1.12.5 Splitting a Log of Battery Units with Identification Problems

There are specific cases where it can be difficult for Battery Monitor to detect that the
battery unit has been replaced by a new one. Different units might identify with an iden-
tical serial number although this is not fully compliant with the Smart Battery industry
standard. As a result, these battery units are recorded in the same log rather than in two
separate logs.

Built-in batteries made by Apple may additionally identify by Apple serial numbers
which can be helpful to resolve such a problem. Typically, a built-in battery is replaced
after it has reached its expected lifetime, and you will no longer use the old one. In this
particular case, Battery Monitor can offer to split the capacity log into two parts, one for
the previous, and one for the current battery unit. This feature is only available under the
following circumstances:

• The two affected battery units identify with the same Smart Battery serial number,
but different Apple serial numbers.

• Battery Monitor has recorded a single capacity log for both units.

• The “newer” battery is currently installed in your computer.

Perform the following steps to split the log at the date where the battery has been
replaced, but has not been detected as a different one:

1. Make sure the window Capacity Log is open and is showing readings, not the graphs.

2. In the column Battery, click onto the line with the battery for which the log should
be split.

3. Right-click the entry and select the item Split Log… in the context menu.

4. Select the date where the log should be separated. This date will become the first
entry of the log of the currently installed battery.

5. Specify the new name for the second part of the log. This name should be related
to the currently installed battery.

6. Press the OK button.

1.12.6 Merging the Logs of two Battery Units

The identification problems mentioned in the previous section can also have the opposite
effect: If an operating system update changed the way how a battery is identified, the
same battery may mistakenly be seen as two different ones, causing multiple capacity
logs to be created. In such a case, it can be helpful to merge the two logs. This is only
possible if the logs don’t contain contradicting entries. The time intervals of the two
logs must only overlap for one day. (The day at which the battery identification policy of
macOS changed.) Perform the following steps for a merge operation:

1. Make sure the window Capacity Log is open and is showing readings, not the graphs.
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2. In the column Battery, click onto the line with the name of one of the battery units
whose log should be merged with another one. The merged log will keep the name
of the first battery selected.

3. Right-click the entry and select the item Merge Log… in the context menu.

4. If there is only one possible candidate to be merged, Battery Monitor will immedi-
ately ask you whether you like to continue. Answer Yes to combine the two logs.
If there are multiple candidates, use the pop-up button in the dialog sheet to select
the other battery for the merge operation and click OK.

1.12.7 Restoring the Capacity Log

If you have moved to a new user account on the same computer, or if parts of your private
home folder have been lost for some reason, Battery Monitor won’t find the capacity log
any more. In this case, you can restore the recorded data from your previous account, or
from a backup copy, respectively.

macOS stores the data of Battery Monitor in the folder Library within your private
home folder. Note that this folder is invisible by default when using the Finder, and this
might also apply for backup copies of that folder. To navigate into your personal Library
folder with the Finder, use the following steps:

1. Hold down the ⌥ (option) key.

2. In the Finder, open the menu Go and select the menu item Library. You can release
the option key now.

You can also make the Library folder permanently visible. For your own copy, this is
possible as follows:

1. In the Finder, select the menu item Go > Home or press ⇧ + ⌘ + H .

2. Open the menu item View > Show View Options or press ⌘ + J .

3. In the option panel, set a check mark at Show Library folder.

Making other copies of Library folders visible is beyond the scope of this manual. To
transfer the capacity log file, perform the following steps:

1. Ensure Battery Monitor is currently not running.

2. Search for the file∼/Library/Containers/com.bresink.app.batterymonitor/Data/Library/
Application Support/BatteryMonitor/BatteryCapacityLog.plist in the previous copy
of your private home folder. In the Finder, this file is visualized at the location Li-
brary > Containers > Battery Monitor > Data > Library > Application Support >
Battery Monitor > BatteryCapacityLog.plist in the backup of your home folder.

3. Copy this file to the very same location in your current home folder. If the file already
exists, replace it.

4. Launch Battery Monitor. It will continue operation with your previous logs.
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1.13 Exporting Readings to other Applications

The complete set of readings recorded by Battery Monitor can be stored into a CSV file. CSV
(Comma-Separated Values) is a universal file format to exchange data organized like tables.
CSV is understood by almost any database, text processing, spreadsheet, or visualization
software, so you can work with the battery readings easily in other applications. Both,
the readings from the history graphs, as well as the full capacity log can be exported.

1.13.1 Exporting the Two-Days Readings

Perform the following steps to export the data:

1. Ensure that at least one history window (section 1.10 on page 23) is visible.

2. Click into the history window to make it come to the foreground.

3. Select the menu item File > Export or press ⇧ + ⌘ + E .

4. A dialog window to select files will be shown. Select the desired folder for storage
and enter a name for the file.

5. Press the button Export.

The file will now be saved into the selected folder. It contains all recorded readings
acquired by the application in the last 48 hours, no matter which history window you had
clicked. In case you don’t need all time recordings or data columns, the program where
you open the CSV file later usually offers features to hide or delete unwanted items.

The first line of the CSV file contains headers for each of the columns. The subsequent
lines contain the values for each time. The exact times are noted in the first column,
sorted in ascending order.

Hint: You can use this feature to manually extend the recording time from 48 hours
to an unlimited duration.

1.13.2 Exporting the Capacity Log

Perform the following steps to export the long-time capacity log:

1. Let the application display the capacity window by selecting the menu item Window
> Capacity Log.

2. Click into the window to make it come to the foreground.

3. Select the menu item File > Export or press ⇧ + ⌘ + E .

4. A dialog window to select files will be shown. Select the desired folder for storage
and enter a name for the file.
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5. Press the button Export.

The file will now be saved into the selected folder. It contains all recorded capacity
readings acquired by the application for all batteries. In case you don’t need all time
recordings or data columns, the program where you open the CSV file later usually offers
features to hide or delete unwanted items.

The first line of the CSV file contains headers for each of the columns. The subsequent
lines contain the values for each date. The exact dates are noted in the first column, sorted
in ascending order.



Chapter 2

General Notes

2.1 Important Release Notes

There are currently no known problems that require additional documentation.

2.2 Version History

2.2.1 Release 5.3 (Build 241129)

• The window for monitoring batteries of connected Bluetooth devices now shows
a USB indicator when an Apple input device is disconnected from Bluetooth but
charged via USB on the same computer.

• The notification feature to show a warning when an AC adaptor is connected for
a long time has been removed. With new systems that support optimized charg-
ing, enforced PowerNap, and third-party applications with a smart “charge inhibit”
feature, it can no longer be estimated reliably whether prolonged charging in an op-
erating computer would actually harm the battery, so the warning no longer makes
sense.

• Added new feature to avoid a technical defect of specific versions of macOS where a
monitored battery of a connected Bluetooth device from Apple can be shown with
changing representations for the device’s serial number, sometimes being replaced
by a Bluetooth address. Battery Monitor will try to show the correct data as soon as
it could learn the relationship between address and number for the affected device.

• Fixed a problem where adding or removing specific Apple Bluetooth input devices
could not be tracked live. A restart of the app may have been needed to update the
Bluetooth window for the affected devices.
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2.2.2 Release 5.2 (Build 240709)

This version suppresses unnecessary checks performed by the App Store that could occur
when starting the App, including the associated windows and possible delays. This could
have affected users who restart their login sessions unusually often or switch between
multiple operating systems on a single computer.

2.2.3 Release 5.1 (Build 240702)

• The main overview window of the application can now be resized.

• Added necessary changes to ensure that the App remains compatible with future
versions of the Mac App Store.

• Legacy code has been removed. The minimum operating system version is now
macOS 13.

2.2.4 Release 5.0 (Build 230626)

• Added new feature to show the connection type of attached AC adapters. This is
supported on operating system versions and Macintosh models that are capable of
reading out the technical specifications of the power supply.

• Added new option to show values in the Dock tile in enlarged fashion.

• The layout of history windows has been optimized. When resizing a window, the
labels for the y-axis keep their widths which leaves more space for the graphs.

• Users who enabled history windows in standard mode and enforced the use of tabs
for document windows in macOS could create compatibility issues with specific
features. To avoid this, Battery Monitor now automatically opts out of using tabs.

• Fixed a problem where the voltage of an attached AC adapter could not be shown in
some versions of macOS.

• Legacy code has been removed. The minimum operating system version is now
macOS 11.

2.2.5 Release 4.9 (Build 230227)

• Application and reference manual have been updated to correctly differentiate be-
tween System Settings of macOS Ventura and System Preferences in older versions
of macOS.

• Fixed a problem where opening System Settings via the context menu of the menu-
bar icon did not work as expected in macOS Ventura.

• A cryptographic security feature was removed to ensure the App can still be imported
to France.
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2.2.6 Release 4.8 (Build 220905)

• In addition to the Touch Bar controls, the battery capacity log can now also opened
directly in graph mode via an item in the main menu, context menu, or via keyboard
shortcuts.

• The wording of the “last full charge cycle” indicator in the long-term overview win-
dow was modified to avoid misunderstandings.

• The code base was modernized to prepare for future operating system versions.

2.2.7 Release 4.7 (Build 220706)

• Added new feature to visualize the differences between state of charge percentage of
the battery cells and battery percentage shown by the operating system. This feature
is available on operating systems and Macintosh models that make this distinction.

• Added new information sheet to explain possible differences between maximum
capacity shown by Battery Monitor and battery status shown by System Preferences.
This feature is available on operating systems and Macintosh models that make this
distinction.

• Added new information sheet showing long-term statistics collected by the battery
unit, e.g. maximum and minimum voltages, currents, temperatures or operating
hours. This feature is available on Macintosh systems with battery units that per-
form this type of data recording.

• Auxiliary windows and information sheets can now also be opened directly via main
menu or Dock menu.

• The new version tries to avoid flicker of some text output elements when the overview
window is already open while the application is still starting up.

2.2.8 Release 4.6 (Build 220325)

• Added new feature to optionally show the estimated remaining time in the Dock
tile of the App. Depending on current charging or discharging process, the value
corresponds to the time it takes for the battery to become full or empty.

• Support for VoiceOver was enhanced in some parts of the App.

• The App is now more robust in cases where a monitored Bluetooth device sends
invalid battery readings.

2.2.9 Release 4.5 (Build 220202)

This is a maintenance update which fixes minor issues:
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• In specific cases, the labels for the y axes in history graphs could be rounded in
confusing or misleading fashion, depending on the accuracy of the corresponding
battery sensors. The number of digits and the rounding method are now optimized
to avoid such issues.

• For specific operating system versions, the feature to open the Energy Saver prefer-
ence pane via the menu icon may have failed.

2.2.10 Release 4.4 (Build 220131)

This is a maintenance update which fixes minor issues:

• In specific cases, the labels for the y axes in history graphs could be rounded in
confusing or misleading fashion, depending on the accuracy of the corresponding
battery sensors. The number of digits and the rounding method are now optimized
to avoid such issues.

• For specific operating system versions, the feature to open the Energy Saver prefer-
ence pane via the menu icon may have failed.

2.2.11 Release 4.3 (Build 220106)

• Added new feature to show a history graph for battery temperature.

• The layout of the main overview window was optimized. This avoids clipped data
fields in some language versions.

• Virtual battery units, used by some desktop computers with Apple Silicon, are no
longer shown as an actual battery.

2.2.12 Release 4.2 (Build 211116)

• Added new feature to show the accessible battery levels of all battery-powered Blue-
tooth devices currently connected to your Mac (no longer restricted to selected Hu-
man Interfaces devices).

• Added full support for macOS 12.

• Removed legacy support for macOS 10.12 and 10.13.

• Updated the handling of manufacturing dates for Apple devices released after August
2021.
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2.2.13 Release 4.1 (Build 210803)

• Added new feature to dismiss the notification panel for the “long charge” warning
by simply plugging the power cord.

• Added new setting to increase the upper possible limit for the “nagging low power
notification” feature from 20% to 66% if the user likes to do so. This can be helpful
for old Macs with defective batteries.

• Added new feature to show possible deviations between the true health value for
maximum battery capacity and fake values sometimes shown by macOS for specific
Macintosh models.

• The activity profile of the App was optimized to avoid that the App Nap feature of
macOS causes readings or other status information to be shown with a noticeable
delay.

2.2.14 Release 4.0 (Build 210412)

• In cases where the combination of Macintosh model and operating system no longer
permit that Apps can access battery manufacturer and manufacturing date reliably,
the application will now show the battery lot codes and version numbers instead.

• The display of the battery serial number has been simplified.

• Fixes a problem where the computer model was not shown as descriptive text for a
few of the latest Macintosh series.

2.2.15 Release 3.9 (Build 201126)

• Added support for the new battery management of the 10th generation MacBook
Air and the 17th generation MacBook Pro. Capacity values and battery unit serial
numbers will now be shown correctly for these models.

• Added a workaround for situations where the operating system provides contradict-
ing battery health information.

• Fixed a problem for Macs with Apple Silicon where the system installation date may
have been shown instead of the manufacturing week.

2.2.16 Release 3.8 (Build 201109)

• Added official support for macOS 11 Big Sur.

• Legacy technology has been removed from the App. The minimum required OS ver-
sion is now macOS 10.12.

• The conditions for merging two long-term battery capacity logs have been relaxed.
This makes it easier to resolve an unintentional split of the database after using beta
operating system versions.
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2.2.17 Release 3.7 (Build 200922)

• Added new feature to merge the capacity logs of two batteries if their time intervals
are compatible.

• The width of the menu-bar display was further optimized for some versions of macOS.

• The battery capacity log has been made more robust against system or window
server crashes.

• Added preparations for future operating system upgrades.

• Fixed a problem where the German translation was incomplete for error messages
of the feature to split capacity logs.

2.2.18 Release 3.6 (Build 200626)

• Added new option to suppress the battery icon in the menu bar if both the menu-bar
item and its percentage display feature are active. This allows you to place Apple’s
battery icon and Battery Monitor’s percentage value next to each other in the menu
bar, combining the best of both worlds.

• The app now accepts that its icon can be replaced by the Finder. This will no longer
raise a security warning.

2.2.19 Release 3.5 (Build 200120)

• Added new feature to display the device type of the AC adapter in its details informa-
tion window. This feature is not available for all combinations of operating systems
and model series.

• Added new feature to display possible error status information for the AC adapter
in the details information window. This feature is not available for all combinations
of operating systems and model series.

• If the status item in the menu-bar is enabled, an additional warning marker will
now be shown in the attached menu when battery servicing is required.

• This version adds a workaround for an ambiguity that could cause an incorrect dis-
play of production dates for Macintosh model series that have up-to-date operating
system support for more than 10 years.

• Added a workaround for a missing battery health assessment field in operating sys-
tems that don’t differentiate correctly between health and error information.

2.2.20 Release 3.4 (Build 191216)

This version adds more explicit error messages for cases where communication with the
AC power adapter fails due to support issues between operating system and specific hard-
ware models.
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2.2.21 Release 3.3 (Build 191016)

• This version adds full support for macOS 10.15 Catalina.

• Legacy technology has been removed from the App. The minimum required OS ver-
sion is now 10.11.

• Added new option to activate nagging, repeating reminder warnings when the charge
level drops below a specified value. The threshold can be set between 5% and 20%.

• The preferences tab to define notifications employs improved user guidance.

2.2.22 Release 3.2 (Build 190410)

• Added support for additional types of Bluetooth Human Interface Devices that will
appear in the respective battery overview.

• Added new feature to automatically repair the long-time battery capacity log in cases
where data corruption is detected.

2.2.23 Release 3.1 (Build 190311)

• The legend of history windows now suppresses the labels for curves which are not
in use for the current battery configuration.

• The Touch Bar buttons to open the total voltage history and the cell voltage history
can now be differentiated correctly.

• Fixed an issue where the window of the battery capacity log may not have been
updated immediately when switching between table mode and graph mode.

2.2.24 Release 3.0 (Build 190220)

• Added new feature to get a simple overview of external batteries in selected Blue-
tooth Human Interface Devices. The current capacities and warning states can be
listed in a window and will also appear in the menu of the menu-bar icon where
available.

• The history windows for total battery voltage and individual cell voltages are now
separate. This makes sure the measured quantities are shown with optimal scales.

2.2.25 Release 2.9 (Build 190128)

This version will change the way macOS activates windows if the App is operated without
a Dock icon. The new policy makes sure windows and notification panels are always
moved to the front when they are opened, so even if the App is visible in the menu bar
only, you can no longer overlook windows that macOS would put behind the currently
active application by default.
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2.2.26 Release 2.8 (Build 180912)

• This version adds full support for macOS 10.14 Mojave.

• Legacy technology has been removed from the App. The minimum required OS ver-
sion is now 10.10.

2.2.27 Release 2.7 (Build 180507)

• Added new option to show a numerical percentage value for the charge level in the
Dock tile.

• Resolved a problem where the main window did not remember its last position for
users who have the Resume feature of the operating system disabled.

2.2.28 Release 2.6 (Build 171025)

• Added new menu items to open the most important windows of the App via the
context menu of the Dock.

• By request of many users, the Dock tile of Battery Monitor can now be removed after
the menu-bar icon has been enabled (macOS Sierra or later only). The menu items
of the App will then move into the menu of the status icon, making it possible to
control the program from there.

2.2.29 Release 2.5 (Build 170808)

By user request, an optional menu-bar icon has been added for macOS Sierra. It can be
used to indicate remaining runtime in the menu, or to get quick access to specific features.

2.2.30 Release 2.4 (Build 170510)

• Added a new feature to display the estimated error of the battery’s capacity value.

• Added a new feature to show an optional warning when the estimated error of the
capacity value becomes too large and the battery needs to be re-calibrated.

• Added a new subsection in the reference manual to document the meaning of the
battery defect list.

• By request, the user interface to control charge level display mode has been re-
designed.

• Numerical readings in the main window are now presented more consistently with
the user’s current locale settings.
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2.2.31 Release 2.3 (Build 161214)

• Added support for computers with Touch Bar.

• Added new feature to suppress recording of capacity log data when the computer
clock has lost its correct date setting.

• Added new feature to indicate the current charge state and the estimated remaining
time in the context menu of the Dock tile.

2.2.32 Release 2.2 (Build 160920)

Optimized for macOS Sierra.

2.2.33 Release 2.1 (Build 160223)

• Added new feature to display technical details about the AC adapter.

• Added new feature to display defects of the battery unit.

• Added new status line to show the system’s health assessment on the battery unit.

• Added new status line to show the system’s recommendation to check or replace
battery units.

• The user can now choose whether the App should show the percentage of the true
physical charge level or of the fake user-presented charge level.

• Added new notification option to report when the fake 100% charge level presented
to the user has been reached.

• In addition to the help book, the reference manual is now also available as printable
PDF document.

• The design of the status indicators in the battery overview window now automati-
cally matches the design of the running operating system.

• Because most portable Macs no longer support user-removable batteries, the “bat-
tery present” indicator was replaced by an “on reserve power” light.

• The features to process expected charge cycle lifetime, remaining operation time,
and “on reserve” status of the battery have been enhanced.

• Fixed a problem with a spurious “on reserve” notification when connecting an AC
adapter immediately after waking from sleep mode.
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2.2.34 Release 2.0 (Build 150219)

• The application has been revised completely and is now optimized for the latest
versions of OS X. Operating systems prior to OS X 10.9 and 32-bit processors are no
longer supported.

• Updated technical information on the latest portable Macintosh computers and bat-
tery units.

• The support for high-quality speech output has been enhanced for non-English lan-
guages.

• The application now suppresses notifications on battery status changes immedi-
ately after waking from sleep mode to give the hardware more time to recover and
stabilize.

• Added new feature to rename batteries in the capacity log.

• Added new feature to split a capacity log for specific cases where a replaced battery
did not correctly identify as a different unit.

• Added workaround for a problem where OS X Yosemite did not update the display
of history windows correctly when switching been head-up and standard display
mode.

2.2.35 Release 1.8 (Build 140211)

• Added support for Timer Coalescing of OS X Mavericks to further enhance energy
consumption.

• The user interface is now refreshed immediately after the computer is waking from
sleep mode.

• Optimized several aspects of the user interface when the App is launched for the
very first time or the first time after an update.

• Enhanced compatibility with certain graphics drivers.

• Updated some technical details in the reference manual for the latest Apple battery
units.

2.2.36 Release 1.7 (Build 140122)

• Added support for the latest portable MacBook computer models.

• Added new option to display the history for capacity readings as percentage values
instead of using mAh.

• Added new feature to display the actual detail reading when clicking on a point on
a history curve.
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• Changed some default colors for history curves to optimize readability independent
of the selected background color.

• Enhanced refresh behavior for the different output windows.

• Due to limitations and technical issues of Growl when supporting native features
of OS X Mavericks, 32 bit systems running Mac OS X Snow Leopard, and the Mac
App Store in one single App, support for Growl notifications had to be removed
unfortunately.

• The reference manual has been revised and uses a new design.

2.2.37 Release 1.6 (Build 130222)

• Added new feature to display the expected remaining number of charge cycles after
which Apple recommends to replace the battery unit.

• Added support for detecting the MacBook Pro with 13-inch Retina display.

• Enhanced compatibility with specific third-party battery packs.

2.2.38 Release 1.5 (Build 120814)

• Support for the Notification Center of OS X Mountain Lion was added. Notifications
on charge or discharge operations can be shown this way if desired.

• Added feature to additionally show the estimated “remaining time to full” when
charging.

• All new mobile Apple computers of the “Mid 2012” generation are now fully recog-
nized.

• Compatibility with Mac OS X 10.7.4 was enhanced.

• The feature to stack history windows was optimized to better utilize space on small
screens.

2.2.39 Release 1.4 (Build 120323)

• Added menu item and keyboard shortcut to open all history windows simultane-
ously.

• Added menu item and keyboard shortcut to close all history windows simultane-
ously.

• History windows now keep automatically open on relaunches, even if you don’t use
Lion’s Resume feature.
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• Added Lion support for all Growl features (not only standard notifications) when
running Battery Monitor together with the Growl App for Lion. (Full Growl func-
tionality was already present in previous versions when using the free version of
Growl with Snow Leopard.)

2.2.40 Release 1.3 (Build 120207)

• Added new feature to monitor the current power of the battery in Watts.

• Added new feature to display a history curve for battery power.

• Additional operating system installations are now supported where users have in-
tentionally deleted parts of the Mac OS X speech synthesizer to gain storage space.
On damaged systems, the App automatically selects fallback voices or deactivates
speech output.

• A problem was resolved where rounding errors affecting the computation of the
time scale in history graphs could accumulate after longer times of operation. This
could cause curves to appear horizontally compressed, showing readings “too early/
too far left”.

• Compatibility with defective battery units has been enhanced.

2.2.41 Release 1.2 (Build 111230)

• Full support for new features of Mac OS X Lion has been added, including Resume
and App Sandboxing.

• A new notification feature was added to inform the user optionally about full charge
and discharge, as well as reaching 10 percent intervals during charge/discharge. No-
tifications can be delivered via speech output or Growl.

• A new optional warning feature was added to inform the user about long, possibly
harmful periods of non-use of the battery during continuous operation on AC power.

• A new graphical view was added to make the long-time capacity history of a battery
visible.

• Short-term readings and the long-time capacity log can be exported to CSV files,
making the values available for database, visualization, or spreadsheet applications.
A synchronization marker can be shown in history diagrams, making it easy to co-
ordinate exact event times in the history curves.

• The maximum time interval to show the graphic history of battery readings has been
extended to 48 hours.

• It is now possible to delete capacity logs of decommissioned batteries.

• When switching the view style of history panels to conventional windows, dragging
behavior and window level will now also be switched accordingly.
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• History data will be saved to secure storage more often, in order not to lose data
when testing defective, unreliable batteries.

• Less storage space is needed for the capacity log.

2.2.42 Release 1.1 (Build 110318)

• Added display line for estimated remaining battery time.

• Added feature to automatically synchronize the time axes of history windows if pre-
ferred by the user.

• Added feature to superimpose history windows.

• Added feature to group history windows, stacking them vertically.

• The capacity log will now always display the latest entry when opening the window.

• The history graphs are now scaled to rounded values, making it easier to read the
axis labels.

• The grid of the history graphs is now organized in 4x4 fashion.

• Corrected a problem where the preference setting to suppress negative currents was
not stored reliably.

• Corrected a problem where an inexact date of production was shown for particular
MacBook models built in 2010 or 2011.

• Corrected a problem where a history window could not be opened under certain
circumstances when using a 32 bit processor.

2.2.43 Release 1.0 (Build 110107)

First official version of Battery Monitor.
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Appendix A

Frequently Asked Questions

A.1 How can I have Battery Monitor start automatically?

Recording the history curves and keeping the capacity log will give better results, as longer
as Battery Monitor has a chance to monitor your battery. The application should run
whenever possible. You can ensure this by letting macOS start Battery Monitor automat-
ically when you log in. Perform the following steps to do that:

1. Start Battery Monitor.

2. Perform a right-click on the tile of Battery Monitor in the Dock.

3. In the Dock’s menu, select the item Options > Open at Login.

Whether the Overview Window should open upon each start can be controlled by the
preferences (section 1.3 on page 2) of Battery Monitor. Deactivating the auto-start feature
is possible by repeating the steps mentioned above.

A.2 How should I take care of my battery?

Each battery unit contains a monitoring processor which operates automatically and
standalone—without any interaction by the computer. It observes the battery and tries
to operate it at such conditions that lifetime is extended as long as possible. For this
reason, regular care and maintenance is not necessary for up-to-date batteries. The bat-
tery can neither be overcharged, nor deeply discharged, because the processor prevents
this. Nevertheless, you should consider the following handling rules on which the battery
processor can have no influence:

• AVOID TOO HIGH AND TOO LOW TEMPERATURES. You should not leave the bat-
tery or the mobile computer in a car. Don’t keep your computer switched on (i.e.
not in sleep mode, but in “clamshell operation”) when it is in a bag or on a soft
underground which might cover the venting openings.

47



48 APPENDIX A. FREQUENTLY ASKED QUESTIONS

• DON’T STORE AN EMPTY BATTERY FOR A LONG TIME. If Battery Monitor or macOS
display that the battery is almost depleted (you are receiving a warning message
that the computer is running on reserve power), you should not leave the battery
in this discharged state for a long time interval. Due to self-discharge which affects
any battery even if it is not in use, the battery could actually discharge to zero level,
and the battery processor cannot prevent this. This deep discharge could severely
harm the battery.

• IF YOU REALLY CANNOT USE A BATTERY FOR SOME EXTENDED PERIOD, prepare it as
follows: Charge, or respectively discharge the battery in the computer until a charge
state of 50% has been reached. After that, store the battery at a cool place, e.g. in a
cellar. Do not put the battery into a refrigerator, however.

• AVOID PERMANENT USE WITH THE POWER SUPPLY. If you don’t use the computer
as a mobile device, but work with it stationary, leaving it always connected to the
AC adapter, you should regularly (e.g. once in a month) allow the battery a full
discharge and an immediate recharge.

In case you are operating a mobile computer with permanent connection to a power
supply, it is nevertheless not recommended to remove the battery to protect it, if this
is possible with your model. Apple computers will run with only half the speed after
that. For further information, please consult the web pages of Apple.

A.3 What does “calibrating a battery” mean?

There is no direct technical possibility to determine the capacity of a battery by some
measuring instrument. The capacity of a battery can only be estimated by observing its
charge and discharge behavior, measuring a series of values like current, voltage and time.

For this reason, the capacity values and remaining run times displayed by macOS and
Battery Monitor are estimates based on previously made observations, recorded by the
charge processor inside the battery unit. The capacity reading and the resulting runtime
are as exact as possible if the charge processor could observe a complete discharge/charge
cycle a short time before. The processor “learns” how the battery is performing and read-
justs its computations based on this behavior. This operation is called “calibrating a bat-
tery”.

Apple recommends to calibrate the battery in regular intervals, usually once in a month.

Note: Portable Apple computers with a non-removable battery (battery unit not re-
placeable by the end user) do not require manual calibration. These batteries come
pre-calibrated and calibrate themselves automatically during normal operation. The
steps outlined below are not necessary for these computer series.

To perform a manual calibration, do the following:
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1. Use the computer without power supply, until you will receive the warning that the
system will now operate on reserve power.

2. Continue to use the computer until it shuts down itself and enters sleep mode au-
tomatically.

3. If your computer is equipped with the feature Safe Sleep, let it remain in this state
for at least 5 hours to ensure that the last reserve of the battery is also discharged.

4. Then reconnect the power supply and let the battery charge to the full maximum
(100% value shown by Battery Monitor while display mode for Current charge is set
to True charge level).

Further information about this procedure might also be found in the reference manual
of macOS which can be opened via the Help menu of the Finder.

Note that calibrating has no influence whatsoever on the battery cells themselves. The
lifetime of the battery unit will not be prolonged by calibration. Only the charge processor
in the battery unit will enhance the quality of its computations and estimates.

A.4 What is the “Smart Battery” standard?

The requirements for batteries are very similar in nearly all computers and other mobile
devices. For this reason, the manufacturers of computers and batteries have agreed on
an industry standard how a battery unit monitors itself and how data and commands
are transferred between computer, battery and charging device. The result is the Smart
Battery Data Specification introduced in 1995.

Nearly all vendors of personal computers use batteries today which are compliant with
the Smart Battery standard. This includes Apple computers with Intel or Apple processors.
The charge processor in the battery unit is linked to the computer by a special data line,
parallel to the power supply lines. This way, the computer can read operational data from
the battery.

A.5 How fast are readings refreshed?

Battery Monitor updates all readings in the overview window once per second. There
should never be a reason to increase or decrease this rate.

The curves in the history windows are being updated once per minute. If you have
never used Battery Monitor on this computer, or if you have used it more than 48 hours
ago, all history windows will be empty, because no history records are available for the
monitored time interval. This is the intended and correct behavior.

Sometimes, you might be under the impression that values in the overview window
change much slower than once per second, in particular the value for estimated remain-
ing run time. Although Battery Monitor tries to update the readings very fast, the battery
processor might not allow to be polled too often per time unit, responding with identical
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values for an extended period of time. Battery Monitor has no influence on this. Limi-
tations in the battery hardware and in the operating system version you are using may
cause a slower effective update rate.


